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OVERVIEW
The purpose of this guide is to assist technicians and engineers 
in integrating Eaton’s motor control products into a new or 
existing EtherNet/IP network, specifically Rockwell Automation 
(RA) Programmable Logic Controllers (PLC). EtherNet/IP (EIP) is 
being used in a wide range of industries and is one of the fastest 
growing industrial protocols in the United States. EtherNet/IP is 
an open source implementation, thus allowing for the continuous 
development and support from industry leaders (such as Eaton), 
and ensuring that this industrial application layer protocol support 
sustainability. 

Instructions and examples will be based on Eaton EIP Assist tool, 
Eaton add-on instructions, RSLINX, and a Compact/ControlLogix™ 
PLC platform, configured with the RSLogix 5000 or Studio 5000 
(RS5K) software environment. This guide will navigate, configure 
and explore the functionality of Eaton EIP-Assist I/O Tag 
Generation tool.

The EIP I/O Tag Generation tool was developed to allow 
technicians and engineers to select multiple Eaton EtherNet/IP 
products, their functions (pre-defined I/O assemblies), and then 
output the compiled data to a Comma Separated Value (CSV) file. 

Once imported into the RS5K environment, these tags are then 
aliased to generic tags created when adding the Eaton module[s], 
thus simplifying integration and reducing commissioning time.

USE OF THIS INFORMATION/

DOCUMENTATION
Nothing in this document or any information or data derived from 
this document may be published distributed or copied nor may 
the information or data be used to create derivative works.  No 
user of this information or data may allow or enable others to 
reverse engineer, decompile, disassemble or otherwise attempt 
to reconstruct, identify or discover any code, underlying ideas, 
techniques or algorithms from this information. No confidential 
information or proprietary rights or data may be removed, obscured 
or altered.

All proprietary and ownership rights belonging to EECO shall 
remain with EECO, and nothing in this document shall relinquish 
such rights, title or interest.

INDEMNIFICATION     
EECO shall be indemnified and held harmless from any and all 
claims, damages, losses and/or expenses, including reasonable 
attorney’s fees, arising from any breach of this agreement or the 
users obligations hereunder.  
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WARRANTY DISCLAIMER
This document is to be used “As Is” without warranty of any 
kind.  EECO, on behalf of itself and any affiliates, hereby disclaims 
all representations, promises or warranties, whether express or 
implied with respect to the information contained herein.  EECO 
specifically disclaims all implied warranties or merchantability, non-
infringement, suitability and fitness for any particular purpose.  

PRE-REQUISITE SKILLS
This document is written and intended for technicians and 
engineers who will be commissioning and/or supporting Eaton’s 
motor control product on the plant floor. The intended users should 
know, at the very least, familiarity with navigating through the RS5K 
software environment. 

REQUIRED HARDWARE/SOFTWARE
1.	 Eaton Motor Control Products  

(DG1 & C445 in our case)

2.	 PC with RSLINX and RS5K

3.	 Rockwell CompactLogix™ or ControlLogix™ PLC (1756-
L71 ControlLogix in our case)

* Note: All Eaton EDS files and software may be downloaded from Eaton.

com via links provided in the Appendices



ROCKWELL AUTOMATION 
ENVIORNMENTS
RSLINX
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Beginning with v20 of RS5K, this may be 
accomplished with other additional options within 
the environment under the Tools Menu. 

Let’s start off by registering the EATON EDS files 
into RSLINX with the EDS Wizard. 

Open the start menu and under RSLINX

STEP 1:	 Select the EDS Hardware 		
	 	 Installation Tool

STEP 2:	 Select add
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Select whether you would like to register a single or a directory of 
EDS files. If the latter, please tick Look in subfolders as well. 

STEP 3:	 Browse to the folder directory containing the EDS[s]

STEP 4:	 Click next

The system will do a scan and populate a test result. 

STEP 5:	 Select the desired file[s] to register 

STEP 6:	 Click next
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Change the icons if needed 
STEP 7:	 Click next 

A final task summary window will appear. Ensure the information is correct. 

STEP 8:	 Click next to complete the EDS registration process



STUDIO 5000 
PART 1
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STEP 5:    Select the chassis type 

STEP 6:    Click finish

STEP 1:	 Open or create a new project in RS5K. 

If starting a new project -  

STEP 2:	 Select the processor and name your project 

STEP 3:	 Browse to the desired project save location

STEP 4:	 Click next 
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In the Controller Organizer - 

STEP 7:    	 Right click the processor Backplane  
	 	 (slot 0) 

STEP 8:    	 Create a new Ethernet module. 

For this example, the 1756-EN2T will be used. Click create

STEP 9:    	 Name the EN2T and input an unused IP 	 	
	 	 Address (192.168.0.2) 

STEP 10:    	 Click OK 

An EN2T module (slot 1) now exists under the Backplane.

7
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Multiple Eaton devices will be added to the project using different methods, with or without an EDS file. The PowerXL DG1 VFD will be 
added as a Generic Ethernet Module and a C445 Smart Motor Protection Device will be utilizing the previously registered EDS file. Using an 
EDS file allows technicians and engineers to select the I/O Assembly pair directly from a drop down list instead of having to input manually.

Next, the Select Module Type window appears. To enter the DG1 as a Generic Ethernet Module - 

STEP 13:    	 Deselect both filters for Category and Vendor and select only Communication and Allen-Bradley

STEP 14:    	 Scroll down toward the bottom of the list and select ETHERNET-MODULE Generic 		
		  Ethernet Module

STEP 15:    	 Click create 

A New Module window will appear. See following page for instructions on adding the next Eaton device.

STEP 11;    	 Right click on the 1756-EN2T module

STEP 12:    	 Select create new module 
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STEP 16:    	 Input a name that is distinctive yet simple (DG1) as 	
		  you will need to reuse this identical name in the EIP 	 	
	 	 Assist Software

STEP 17:    	 Change the Comm Format from DINT >> INT 

STEP 18:    	 Input an unused IP Address (192.168.0.100 that is 		
	 	 on the same subnet as the EN2T, i.e. 192.168.0.x. {x 	
	 	 = 2-254}

STEP 19:    	 Input 73 for the Input Assembly Instance, size = 		
		  3 bytes (INT) (pg. 66 in DG1 Manual)

STEP 20:    	 Input 23 for the Output Assembly Instance, size 		
		  = 3 bytes (INT) (pg. 62 in DG1 Manual)

STEP 21:    	 Configuration assembly is not used, but 	 	 	
	 	 there must be a value there as a place holder so 	 	
		  input 1 for Configuration Assembly Instance, size = 0 

Adding the next Eaton device, a C445, is similar to the previous steps with minor changes. 

STEP 22:    	 Right click on the 1756-EN2T module again and select create new module. 

STEP 23:  	 The Select Module Type window reappears

STEP 24:    	 Deselect the filters for Vendor and select only Eaton Electrical 

The list will only show Eaton devices based on the EDS files that were previously registered 

STEP 25:    	 Select C445XC-E C445 EtherNet Communication Card 

STEP 26:    	 Click create

A New Module window appears
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Input a name that is distinctive yet simple (C445) as you will need to reuse this identical name in the EIP Assist Software. 

STEP 27:    	 Input an unused IP Address (192.168.0.101) that is on the same subnet as the EN2T, i.e. 192.168.0.x. {x = 2-254}.

STEP 28:    	 Click the change button 

STEP 29:    	 Change the size from SINT >> INT
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STEP 30:    	 Click on ExclusiveOwner and select the I/O Assembly on  		
		  106 OT – 110 TO. 

Notice the size changed on the Input and  Output to 11 & 1

STEP 31:    	 Click OK and select Yes 

Back on the New Module Window - 

STEP 32:    	 Select the Connection Tab to change the RPI or select OK. 

STEP 33:    	 Close the Select Module Type window.

In the Controller Tags window, notice the general tags that were created when 
we added the Eaton EtherNet/IP modules. 

STEP 34:    	 Save the project

*Ensure that the RS5K project file is saved periodically to mitigate the risk of 

losing data. 
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Normally, technicians or engineers manually input information in the Description column, but this can take days if not weeks depending on the 
tag counts. Eaton recognized this barrier and developed the EIP-Assist tool to help technicians and engineers eliminate this burden.

At this point, allow RS5K to continue to run in the background. Let’s navigate to the location where the Eaton EIP-Assist tool was downloaded.

17



EATON’S ETHERNET  
CONFIGURATOR  
1.3.16
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STEP 1:    	 Start EIP-Assist by double clicking the icon. 

STEP 2:    	 The splash screen will appear indicating the tool is initializing.
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EIP-Assist will ask if an EDS file is being used for the first product. 

STEP 3:    	 In our case we did not use an EDS to add the DG1, so select no 

STEP 4:    	 Enter the number of DG1 devices we added to our project -  
		  1 in our case.

But if multiple DG1 were added, we could generate the tags in one instance utilizing 
EIP-Assist.

STEP 5:    	 Select the appropriate DG1 I/O Assembly Pair as previously 	 	
	 	 completed in the RS5K project; 23/73 in this example. 

STEP 6:    	 Comm Format was also set to INT, so select yes.
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7

STEP 7:    	 Browse to a location where the outputted CSV will be saved. 

Please note the location as the CSV will need to be accessed at a later time.

STEP 8:    	 Name the CSV file to be outputted

This can be anything. In this example, EECO EIP ASSIST DEMO will be used. 

STEP 9:    	 Click OK

STEP 10:    	 Enter the DG1 Device Name as completed in the RS5K project - 	 	
	 	 enter DG1

STEP 11:    	 Click OK

*THE NAME MUST BE IDENTICAL in order for the tool to properly generate the desired 

tags! 
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STEP 15:    	 Select Power Xpert C445

STEP 12:    	 Select yes to configure the additional product

STEP 13:    	 The EIP-Assist tool will loop back to the original prompt of whether an 	
	 	 EDS is to be utilized. Referring back to the second Eaton product that 	
	 	 was added, the EDS file was indeed utilized. 

STEP 14:    	 Select Yes
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7

8

STEP 17:    	 Click Yes for Comm Format INT

Similar to the DG1 instance - 

STEP 16:    	 Input the value of 1 for the C445 Device count. If additional 	
		  C445s were added, enter the corresponding value.

STEP 17:    	 Select the 106/110 I/O Assembly Pair as in the RS5K Project
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STEP 17:    	 Enter the C445 Device Name as completed in 	 	
	 	 the RS5K project

*THE NAME MUST BE IDENTICAL in order for the tool to properly generate the 

desired tags! 

STEP 18:    	 Click OK

STEP 19:    	 Select No for configuring additional product.

A final window will pop up to show the CSV file name and folder location. 

STEP 20:    	 Click OK

EIP-Assist will automatically close any remaining windows and the task is 

completed.



STUDIO 5000
PART 2
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Navigate back to the RS5K environment - 

STEP 1:    	 Go to the Tools Menu > Import > Tags 	
		  and Logic Comments

STEP 2:    	 Browse to the previously saved CSV 		 	 	 	
	 	 folder location, select, and import
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Once the import task is completed, you will notice the lower Error plane that provides feedback on how many tags were created, along with any 
errors and warnings. 

*If there are error[s], ensure that the names specified in the project and EIP-Assist were identical, or re-run EIP-Assist with the correct nomenclature.

Also notice that the description column is now automatically populated from the EIP-Assist generated CSV. When Edit Tags is selected, RS5K 
will also show exactly where the new tags are alias to in the generic tags. The functionalities of the EIP-Assist tool contribute to the reduction of 
setup or commissioning time by a great amount, ultimately reducing downtime and increasing productivity. The import task is now completed.
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Eaton has taken additional steps to simplifying integration of its 
EtherNet/IP supported products by offering a wide range of Add-On 
Instruction (AOI) that may be used in conjunction with or without EIP-
Assist. 

The AOI method is the preferred method of commissioning Eaton’s 
smart devices as the front end work of mapping, combining two byte/
word tags into an INT, DINT, or REAL, and the scaling has already 
been completed. 

Technicians and engineers will then focus only on the application 
programming phase. Let’s proceed and explore how technicians and 
engineers can utilize Eaton’s AOIs.

In RS5K - 

STEP 4:    	 Navigate to File > Import Component > Add-On 		
		  Instruction 

STEP 5:    	 Browse to the AOI provided by Eaton

The extension of the file will be a L5X. 	

STEP 6:    	 The medium frame size C445 AOI is selected. 
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The Import Configuration window appears.

STEP 7:    	 Verify and select OK

STEP 8:    	 In the Controller Organizer > Add- On  Instruction, 	
	 	 the AOI has been successfully imported and is now 		
		  available for use in the Language Element Tool 			 
		  Bar > Add-On
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STEP 9:    	 In MainProgram > Parameters and Local Tags, it’s apparent that RS5K created the AOI I/O tags within this location. 



UTILIZING THE  
AOI
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STEP 1:    	 Next, open MainProgram – MainRoutine 

STEP 2:    	 Add a rung 

STEP 3:    	 Then in Add-On, drag the C445 AOI to the rung 0

Once the C445 AOI block is added to the rung, the top three parameters 
in the AOI block must be mapped to a specific module.

Within the AOI block - 

STEP 4:    	 Double click the top “?” next to the View Configuration 	
	 	 Dialog button

STEP 5:    	 Input C445 > right click > select “New C445” 

STEP 6:    	 A new Parameter or Tag window will appear

STEP 7:    	 Confirm the name and scope

STEP 8:    	 Click create

Ensure that the Controller Tags and MainProgram windows are open and 

side-by-side. 

STEP 9:    	 Expand both C445:I1 and C445:O1

STEP 10:    	 Select and drag C445:I1:Data to the “?” in the Input row 

STEP 11:    	 Select and drag C445:O1:Data to the “?” in the 	 	
	 	 Output row. 

STEP 12:    	 Select and drag C445:I1:ConnectionFaulted to the “?” in 	
	 	 the Comms_Status row. 

The setup of the AOI is now complete.
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Let’s create a DINT tag —

STEP 13:    	 name it Input_Output. 

The Boolean within the DINT will be used as 
logical Push Buttons. 

STEP 14:    	 Add a couple of rungs to the 		
	 	 project

STEP 15:    	 Enable remote FieldBus control of 	
	 	 the C445 by latching the 	 	
	 	 C445_Enbl_	 	 Ctl_ Net bit. 

To ensure that the PLC has control after a power 
loss, a First Scan bit is used for latching on a 
power-up condition. 

STEP 16:    	 Add a start, stop and fault logic to 	
	 	 the program, 

STEP 17:    	 Download to the processor

The C445 is ready for operation. 



APPENDICES
A, B
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EATON RESOURCE DOWNLOADS LINKS

 Eaton Software Downloads
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/
SoftwareDownloads/index.htm

 EIP Assist Software
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/
SoftwareDownloads/index.htm?litlibtarget=2000000000866

 Eaton C445
http://www.eaton.com/Eaton/ProductsServices/Electrical/
ProductsandServices/AutomationandControl/ContactorsStarters/
MotorProtectionRelays/C445/index.htm?wtredirect=www.eaton.com/
c445#tabs-3

 Eaton C440/C441
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support 
SoftwareDownloads/index.htm?litlibtarget=2000000000835

 Eaton PowerXL DA1
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/
SoftwareDownloads/index.htm?litlibtarget=2000000001137

 Eaton PowerXL DG1
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/
SoftwareDownloads/index.htm?litlibtarget=2000000000867

 Eaton SVX 9000
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/
SoftwareDownloads/index.htm?litlibtarget=2000000000726

 Eaton S811+/S801+ Soft Starter
http://www.eaton.com/Eaton/ProductsServices/Electrical/
ProductsandServices/AutomationandControl/ContactorsStarters/
SoftStartersControllers/S811S801Plus/PCT_377642

http://www.eaton.com/SEAsia/ProductsSolutions/Electrical/ProductsServices/
AutomationControl/SolidStateMotorControl/SoftStarters/S811Series/index.
htm#tabs-1

 E-Series Protective Relay
http://www.eaton.com/Eaton/ProductsServices/Electrical/
ProductsandServices/ElectricalDistribution/PowerDistributionComponents/
ProtectiveRelays/MotorRelays/EMR-4000/index.htm

http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/
SoftwareDownloads/index.htm?litlibtarget=2000000000987

http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000866
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000866
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/MotorProtectionRelays/C445/index.htm?wtredirect=www.eaton.com/c445#tabs-3
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/MotorProtectionRelays/C445/index.htm?wtredirect=www.eaton.com/c445#tabs-3
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/MotorProtectionRelays/C445/index.htm?wtredirect=www.eaton.com/c445#tabs-3
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/MotorProtectionRelays/C445/index.htm?wtredirect=www.eaton.com/c445#tabs-3
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support SoftwareDownloads/index.htm?litlibtarget=2000000000835
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support SoftwareDownloads/index.htm?litlibtarget=2000000000835
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support SoftwareDownloads/index.htm?litlibtarget=2000000000835
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support SoftwareDownloads/index.htm?litlibtarget=2000000000835
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000867
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000867
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000726
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000726
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/SoftStartersControllers/S811S801Plus/PCT_377642
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/SoftStartersControllers/S811S801Plus/PCT_377642
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/AutomationandControl/ContactorsStarters/SoftStartersControllers/S811S801Plus/PCT_377642
http://www.eaton.com/SEAsia/ProductsSolutions/Electrical/ProductsServices/AutomationControl/SolidStateMotorControl/SoftStarters/S811Series/index.htm#tabs-1
http://www.eaton.com/SEAsia/ProductsSolutions/Electrical/ProductsServices/AutomationControl/SolidStateMotorControl/SoftStarters/S811Series/index.htm#tabs-1
http://www.eaton.com/SEAsia/ProductsSolutions/Electrical/ProductsServices/AutomationControl/SolidStateMotorControl/SoftStarters/S811Series/index.htm#tabs-1
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/ElectricalDistribution/PowerDistributionComponents/ProtectiveRelays/MotorRelays/EMR-4000/index.htm
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/ElectricalDistribution/PowerDistributionComponents/ProtectiveRelays/MotorRelays/EMR-4000/index.htm
http://www.eaton.com/Eaton/ProductsServices/Electrical/ProductsandServices/ElectricalDistribution/PowerDistributionComponents/ProtectiveRelays/MotorRelays/EMR-4000/index.htm
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000987
http://www.eaton.com/Eaton/ProductsServices/Electrical/Support/SoftwareDownloads/index.htm?litlibtarget=2000000000987
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EATON SUPPORTED PRODUCTS AND THEIR RESPECTIVE I/O ASSEMBLIES

 Supported Devices

 C441R C441 120 VAC

105/50
105/51
105/100
105/107
105/110
105/115
105/121

 C441T C441 24 VDC 

105/50
105/51
105/100
105/107
105/110
105/115
105/121

 C441R S611 120 VAC  

105/60
105/100
105/107
105/108
105/121
105/131
105/133
106/60
106/100
106/107
106/108
106/121
106/131
106/133

 C441T S611 24 VDC 

105/60
105/100
105/107
105/108
105/121
105/131
105/133
106/60
106/100
106/107
106/108
106/121

106/131
106/133

 C441U C440 120 VAC

105/60
105/107
105/120
105/130

 C441V C440 24 VDC  

105/60
105/107
105/120
105/130

 C441U S811+ 120 VAC 
I/O

101/61
101/102
101/110
101/111
101/120
101/121
101/130
101/131
101/140
101/141
101/150

 C441V S811+ 24 VDC

101/61
101/102
101/110
101/111
101/120
101/121
101/130
101/131
101/140
101/141
101/150

 C441U I/O 120 VAC 

32/3
32/107

 C441V I/O 24 VDC 

32/3
32/107

 SVX/SPX 9000X OPTCQ

21/71
23/73
25/76
101/127
111/127
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 PowerXL DG1 drive

20/70
20/71
20/73
20/107
20/117
20/127
21/70
21/71
21/73
21/107
21/117
21/127
23/70
23/71
23/73
23/107
23/117
23/127
101/70
101/71
101/73
101/107
101/117
101/127
111/70
111/71
111/73
111/107
111/117
111/127

 Power Xpert C445 Smart
2/50
2/51
2/52
2/54
2/100
2/107
2/110
2/116
2/121
3/50
3/51
3/52
3/54
3/100
3/107
3/110
3/116
3/121
5/50
5/51
5/52
5/54
5/100
5/107
5/110
5/116
5/121
104/50
104/51
104/52
104/54

104/100
104/107
104/110
104/116
104/121
105/50
105/51
105/52
105/54
105/100
105/107
105/110
105/116
105/121
106/50
106/51
106/52
106/54
106/100
106/107
106/110
106/116
106/121


